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Descripción del Kit de iniciación AC500-eCo 

Información general sobre el Kit de iniciación AC500-eCo  
Las CPU series PM554 y PM564, de la gama AC500-eCo, son los modelos introductorios de la familia de 
plataformas AC500 de ABB. 

Este Kit de iniciación AC500-eCo le introducirá al mundo de los PLC de ABB y le ayudará a familiarizarse 
con el software de programación. Para ello, este manual explica cómo conectar y configurar los 
componentes suministrados en el Kit de iniciación y cómo programar el PLC mediante sencillos ejemplos 
de aplicaciones. 

Contenido del Kit de iniciación AC500-eCo 
 1 CPU AC500-eCo PM554-T (8 entradas digitales de 24 V CC / 6 salidas de transistor) 

 1 módulo de alimentación externo CP-E 24/0.75 (24 V CC) 

 1 cable de programación USB TK503  

 1 CD “Starter Kit” (Kit de iniciación) con una versión completa del software de programación PS501 

 1 CD “Getting Started” (Primeros pasos) 

 Este Manual de primeros pasos 

 1 destornillador 

 1 bolsa de promoción de los PLC de ABB 

Breve descripción de la CPU AC500-eCo PM554-T  
La CPU PM554-T es una unidad central (unidad básica) para la plataforma de control Advant Controller 
500 (AC500). Sus principales características son: 

 Memoria para programas de 128 KB 

 Ampliación mediante un máximo de 7 módulos de E/S a través del bus de E/S 

 Hasta 2 puertos serie para programación y comunicación 

 Puerto COM1 integrado (D-Sub 9, interfaz serie RS-485) 

 Puerto COM2 opcional (terminal de 5 polos, interfaz serie RS-485) 

 8 entradas digitales configurables integradas de 24 V CC 

 4 entradas de interrupción (canales I0…I3) 

 2 entradas de contador rápido (canales I0 e I1) 

 6 salidas de transistor configurables integradas de 24 V CC, 0,5 A 

 2 salidas PWM (canales DO2 y DO3) 

 Interruptor MARCHA/PARO integrado 

 Adaptador para tarjeta SD opcional 

 Fuente de alimentación de 24 V CC 
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Elementos de funcionamiento, indicación y conexión de PM554-T 
La figura que aparece a continuación muestra los siguientes elementos de funcionamiento e indicación. 

1. LED PWR verde. Iluminado = Alimentación de la CPU conectada 

2. LED RUN verde. Iluminado = CPU en modo de funcionamiento 

3. LED ERR rojo. Iluminado = Indicación de error 

4. Asignación de nombres de señal 

5. 14 LED amarillos para indicar el estado de cada entrada (8 ED) y salida (6 SD) 

6. Cubierta opcional del adaptador para tarjeta SD e interfaz COM2 (RS-485) 

7. Interruptor RUN/STOP (marcha/paro) 

8. Asignación de números de terminal 

9. Asignación de nombres de señal 

10. Bloque de terminales de tornillo para las E/S integradas (fijo) 

11. Interfaz de comunicación serie COM1 (RS-485) 

12. Bloque de terminales de alimentación de CC (entrada de 24 V CC en el lado izquierdo y salida de 
24 V CC en el lado derecho) 
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Breve descripción del software Control Builder PS501 
El software Control Builder PS501 es la herramienta de ingeniería para todas las categorías de 
rendimiento de las CPU AC500. Se utiliza para la programación estandarizada conforme a IEC 61131-3 
en seis lenguajes diferentes.  

El software Control Builder está basado en el software CoDeSys (Controlled Development System) 
desarrollado por 3S Automation.  

El software Control Builder PS501 forma parte de la Automation Alliance. 

 
El editor y las funciones de depuración están basados en entornos de desarrollo contrastados de 
lenguajes de programación de alto nivel. El Kit de iniciación de PS501 proporciona una versión completa 
del software pero sin el servicio de actualización. 

 

Manual de primeros pasos      5 Kit de iniciación AC500-eCo     AC500/Publicado: 04.2010 



Características del software 
Entre muchas otras, el software presenta las siguientes características: 

 Programación conforme a IEC 61131-3 

 cinco lenguajes de programación IEC estandarizados: diagrama de bloques de función (Function 
Block Diagram, FBD), lista de instrucciones (Instruction List, IL), diagrama de escalera (Ladder 
Diagram, LD), texto estructurado (Structured Text, ST) y diagrama de funciones secuenciales 
(Sequential Function Chart, SFC)   

 editor CFC (Continuous Function Chart, diagrama de funciones continuas) libre 

 Funciones de depuración para probar el programa de aplicación: paso único (Single step), ciclo 
único (Single cycle) y puntos de ruptura (Breakpoints) 

 Simulación offline (solo para funciones CoDeSys por defecto) 

 Señales de muestreo 

 Visualización 

 Configuración de las interfaces de comunicación 

Todos los componentes del programa disponen de ayuda 
El software Control Builder PS501 incluye detallada información de ayuda en línea. Para invocar la 
ayuda, seleccione el menú Help (ayuda) o pulse F1 para obtener información. 
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Instalación del Kit de iniciación AC500-eCo 
Extraiga del embalaje los módulos del Kit de iniciación. Siga el procedimiento descrito a continuación 
para instalar los componentes de hardware y software. 

Instalación del hardware del Kit de iniciación 
Montaje de la CPU y del módulo de alimentación en una guía DIN  

1. Introduzca el módulo de la CPU en el lado superior de la guía DIN y presione la parte inferior del 
módulo contra la guía DIN. 

2. El módulo de la CPU queda enganchado a la guía DIN con un "clic" audible. 

 
Proceda del mismo modo para montar el módulo de alimentación en la guía DIN. 

Conexión de la fuente de alimentación de 24 V CC a la CPU PM554-T

 
NOTA 

El módulo de alimentación CP-E 24/0.75 se suministra con instrucciones de instalación.  
Lea atentamente las instrucciones antes de conectar el módulo de alimentación. 

 
El módulo de la CPU PM554-T necesita una alimentación de 24 V CC. Dispone de un bloque de 
terminales de tornillo de 5 patillas para conectar la alimentación. 

La asignación de patillas de los terminales es la siguiente: 
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Conecte los terminales L+/M de la CPU de la izquierda (entrada de alimentación) a los terminales L+/M 
del módulo de alimentación. Asegúrese de conectar los cables correctamente. 

 
ATENCIÓN 

Peligro de daños en el equipo o de lesiones personales 
Respete siempre las regulaciones vigentes sobre seguridad al instalar, manipular y 
poner en funcionamiento equipos eléctricos. No seguir estas instrucciones y normas 
puede ocasionar daños al equipo, lesiones personales o incluso la muerte. 

 
ATENCIÓN 

Peligro de daños en la CPU y los módulos conectados 
Las tensiones superiores a 30 V CC pueden destruir la CPU y los módulos conectados a 
ella. Asegúrese de que la tensión de alimentación nunca supera los 30 V CC. 

  
En los terminales de la derecha de este conector (salida de alimentación) pueden conectarse los 
sensores que recibirán alimentación del módulo de la CPU. Obsérvese que los terminales M están 
conectados internamente. Esta alimentación puede conectarse fácilmente a las entradas digitales 
integradas para alimentarlas. 

Instalación del software del Kit de iniciación 

Instalación de la herramienta de ingeniería Control Builder PS501 
1. Inserte el CD del Kit de iniciación AC500-eCo en la unidad de CD de su ordenador. 

  

 Si su unidad de CD está configurada para ejecución automática, el menú de instalación se abrirá 
automáticamente. 

 En caso contrario, abra manualmente el menú de instalación ejecutando el archivo 
CD_Menu_V5x.exe del directorio raíz del CD-ROM.  

Esto puede hacerse, por ejemplo, seleccionando Inicio > Ejecutar (en el menú de Inicio de 
Windows) e introduciendo [unidad]:\CD_Menu_V5x.exe en la ventana que se abre. 

 Aparece la siguiente ventana de instalación de PS501. 

¡Error!
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2. Si lo desea, puede cambiar el idioma de la interfaz seleccionando una entrada del cuadro de lista 
Please select language (seleccione un idioma) 

3. Si lo desea, haga clic en Read me for installation para ver información adicional sobre la 
instalación del software. 

4. El proceso de instalación está dividido en varios pasos. En el menú de instalación del CD, cada uno 
de estos pasos está representado como un botón diferente. 

Para utilizar el Kit de iniciación solamente es obligatorio instalar la herramienta de ingeniería PS501 
(Step 1:…). Los demás pasos de la instalación son opcionales. Durante la instalación del software 
de programación se instalan, además, los controladores de comunicación necesarios y el servidor 
OPC.  

 Comience el proceso de instalación haciendo clic en Step 1: Installation Control Builder PS501 
(paso 1: instalación de Control Builder PS501) 

 Recomendamos instalar adicionalmente la documentación de la CPU PM554-T. Para ello, haga 
clic en el botón Opt.1: Installation Documentation (opc. 1: instalación de la documentación). 

 Si necesita todos los componentes, complete los demás pasos de la instalación haciendo clic en 
los botones Step 2: … y Step 3: … Como se ha explicado anteriormente, esto no es necesario 
para utilizar el Kit de iniciación. 
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Instalación del controlador del cable de programación TK503 
Antes de conectar el PLC al ordenador mediante el cable de programación TK503, es necesario instalar 
el controlador en el ordenador. 

La comunicación entre el ordenador y el PLC tiene lugar a través del cable TK503. De esta forma es 
como, por ejemplo, se descarga el programa desde el software de programación al módulo de CPU PLC 
PM554-T. 

 

 
CONSEJO 

El CD del software PS501 incluye instrucciones de instalación detalladas:  
[drive]:\CD_AC500\Driver\TK503\TK503_Driver_Installation.pdf. 

  
1. El archivo del controlador está en el CD del Kit de iniciación con el software PS501, en el directorio  

[unidad]:\CD_AC500\Driver\TK503. 

Haga doble clic en el archivo TK503&TK504Installer.exe para iniciar la rutina de instalación. 

 

2. En el cuadro de diálogo que se abre, haga clic en Install (instalar) y siga las instrucciones. 

3. Tras completar correctamente la instalación, conecte el cable de programación TK503 a:  

 la interfaz USB del ordenador 

 la interfaz serie COM1 del PLC. 

4. Cuando se conecta el cable de programación TK503 por primera vez, Windows detecta que se ha 
conectado un nuevo dispositivo USB y se abre la ventana Asistente para nuevo hardware.  

5. Siga las instrucciones con los ajustes mostrados a continuación. 
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 Se busca e instala el controlador del cable de programación TK503. 

6. Espere a que Windows indique que la instalación se ha realizado correctamente.  
Confirme el cuadro de diálogo que se abre haciendo clic en Finish (terminar). 

Una vez instalados el hardware y el software podrá programar algunos ejemplos de aplicaciones para su 
PLC de ABB. 
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Ejemplo de programación 
El ejemplo siguiente proporciona una introducción paso por paso al software Control Builder PS501, 
presentando de esta forma los fundamentos de programación de los PLC de ABB.  

Puede aprender cómo programar el PLC AC500-eCo si completa este ejercicio.   

Ejemplo: Primeros pasos con una función AND en FBD 
En este primer ejemplo, va a “desarrollar” un proyecto de aplicación muy sencillo. Utilizaremos el 
lenguaje de programación FBD. 

Creación de un nuevo proyecto 
1. Abra el software de programación PS501 (CoDeSys). 

 

2. Cree un nuevo proyecto haciendo clic en el botón New (nuevo) o seleccionando la opción de menú 
File > New (archivo > nuevo). 

 

3. En la ventana Target settings (ajustes de objetivo), seleccione la CPU AC500 PM554 V1.3 en la lista 
desplegable Configuration (configuración). 
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4. En este momento no es necesario realizar otros ajustes de objetivo.  
Simplemente haga clic en OK para cerrar la ventana. 

 

5. En la ventana New POU (nueva POU), especifique el tipo y lenguaje de la POU (Program 
Organization Unit o unidad de organización de programa) como se muestra en la captura de 
pantalla. A continuación, confírmela con OK. 

 
NOTA 

No cambie el nombre propuesto (PLC_PRG). 

  

Manual de primeros pasos      13 Kit de iniciación AC500-eCo     AC500/Publicado: 04.2010 



Guardado del proyecto 
1. Haga clic en el botón Save (guardar) o seleccione la opción de menú File > Save (archivo > 

guardar). 

 

2. Elija la carpeta de destino, introduzca My_First_Project como nombre de proyecto y haga clic en 
Save. 
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Especificación de la configuración de hardware 
Para especificar la configuración de hardware es necesario definir las E/S y sus nombres simbólicos. 

1. Abra la pestaña Resources (recursos, en la parte inferior de la ventana) y haga doble clic en el 
icono PLC Configuration (configuración del PLC). 

 

2. En el árbol de estructura del hardware de la derecha, abra los siguientes nodos del árbol haciendo 
clic en el signo “+” situado delante de las entradas correspondientes (véase la figura siguiente): 

AC500 
 Onboard IO: 8DI+6DO(SLOT) 
  Digital Inputs 0-7(FIX) 
   Digital Outputs 0-5(FIX)
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3. Para introducir un nombre simbólico para Input 4, haga clic dos veces (no doble clic) en la palabra 
clave AT e introduzca el nombre DI04.  

Pulse <Intro> para aplicar la entrada. 
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4. Repita el paso  3 para declarar: 

 Input 5 como DI05 

 Output 0 como DO00 

 Output 1 como DO01 

 Ahora la configuración debe tener este aspecto: 
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Escritura del código del programa en el editor de bloques de función 
1. Para poder modificar el programa debe abrir la pestaña POUs (en la parte inferior de la ventana) y 

hacer doble clic en el icono PLC_PRG (PRG). 

 

 En el borde de la ventana de la izquierda se indica el número de red (0001 en nuestro ejemplo).  

 

2. Existen dos formas de añadir un elemento( un cuadro, por ejemplo) a la red activa: 

 Hacer clic en el icono Box (cuadro). 

O bien: 

 Hacer clic con el botón derecho en la red y seleccionar Box en el menú contextual. 

Añada un cuadro AND utilizando uno de estos dos métodos. 
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CONSEJO 

Cuando se introduce un nuevo cuadro, este siempre aparecerá como un bloque AND. 
Puede cambiar el bloque en cualquier momento haciendo clic en el nombre del bloque y 
escribiendo un nombre distinto. 

  
3. Introduzca los nombres de ambas entradas del modo siguiente:  

Haga clic en el marcador de posición ??? e introduzca el nombre DI04 para la entrada 1 y DI05 para 
la entrada 2. 

 

 

4. Añada un Assign (asignar) empleando uno de los métodos descritos en el paso 2. 

Cuando añada un elemento a la red, siempre tiene que hacer clic en el área . 
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5. Introduzca un nombre para la salida: Haga clic en ??? y escriba DO00. 

 Ahora el código debe tener este aspecto: 

 

6. Haga clic con el botón derecho en el número de red 0001 y seleccione Network (after) (red 
[posterior]) en el menú contextual. 

 

7. Añada un Assign empleando uno de los métodos descritos en el paso 2. 

 

8. Dé un nombre a la entrada y a la salida haciendo clic en el marcador de posición ???. 
Introduzca DO00 para la entrada y DO01 para la salida, como se muestra a continuación. 
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9. Introduzca una negación de este modo: haga clic con el botón derecho en la posición mostrada en la 
figura siguiente y seleccione Negate en el menú contextual. 

 

 Ahora el código debe tener este aspecto: 

 

10. Introduzca un comentario en la red del modo siguiente: Haga clic con el botón derecho en Network 
0001 y seleccione Comment en el menú contextual. 
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11. Para modificar el comentario, haga clic en el texto Comment.  

 

12. Introduzca DI04 AND DI05 = DO00 y haga clic en cualquier lugar para confirmar la entrada. 

 Ahora las redes 0001 y 0002 deben tener este aspecto: 

 

13. Guarde el programa haciendo clic en el botón Save o seleccionando la opción de menú  File > 
Save. 
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Compilación del proyecto 
Asegúrese de haber guardado el proyecto antes de compilarlo. La compilación del programa se realiza 
con las opciones de menú Build (compilar) o Rebuild all (recompilar todo). 

 Si se utiliza el comando Build solamente se recompilan las POU modificadas. 

 Si se ejecuta el comando Rebuild all se recompila todo el proyecto (todas las POU). 

 

Una vez compilado correctamente el proyecto, el cuadro de mensajes debe tener este aspecto: 
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Configuración de los parámetros de comunicación 
Antes de que pueda descargar el programa compilado desde el ordenador al PLC, debe configurar los 
parámetros de comunicación. Proceda de este modo: 

1. En el menú Online (en línea), seleccione Communication Parameters (parámetros de 
comunicación). 

 

2. En el cuadro de diálogo Communication Parameters, haga clic en el botón Gateway (pasarela). 
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3. En el campo Connection (conexión), seleccione Local y haga clic en OK para confirmar. 

4. Haga clic en el botón New para añadir un nuevo canal. 
En el cuadro de diálogo New Channel (nuevo canal) que se abre, rellene el campo Name (nombre), 
seleccione Serial (RS232) como Device (dispositivo) y confírmelo con OK. 

 

5. Seleccione el parámetro adecuado haciendo doble clic sobre él. Para modificar un parámetro, utilice 
las teclas de cursor arriba y abajo. 

 
NOTA 

Los parámetros de comunicación deben coincidir con los parámetros COM1 especificados 
en la configuración del PLC. 
El número de puerto debe ser igual que el número incluido en el Administrador de 
dispositivos de Windows (véase el apartado Detección del número de puerto correcto 
(interfaz COM) a continuación). 
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Ajuste los parámetros tal como se muestra a continuación y confírmelos haciendo clic en OK. 

 

Detección del número de puerto correcto (interfaz COM) 
1. En el menú de Inicio de Windows, seleccione Inicio > Configuración > Panel de control. 

Haga doble clic en el icono Sistema. 

 

2. En el cuadro de diálogo Propiedades del sistema que aparece, abra la pestaña Hardware y haga 
clic en el botón Administrador de dispositivos. 
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3. En el árbol de dispositivos, abra el nodo Puertos (COM & LPT).  

 En el extremo de la entrada TK503/TK504 programming cable se indica el número de puerto 
COM necesario (COM7 en nuestro ejemplo). 

 

Prueba del programa sin conexión con el hardware del PLC 
Puede probar el programa en el modo de simulación offline. En este modo el hardware del PLC no es 
necesario. 

1. Seleccione la opción de menú Online > Simulation Mode (en línea > modo de simulación). 
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2. Seleccione la opción de menú Online > Login (en línea > iniciar sesión) para iniciar realmente el 
modo de simulación. 

 

 El símbolo  delante de la opción de menú Simulation Mode (modo de simulación) indica que 
el modo de simulación está activo. 

3. Para simular el programa del PLC, seleccione la opción de menú Online > Run (en línea > ejecutar). 

 

4. Abra de nuevo la vista PLC Configuration (configuración del PLC). Aquí cada entrada y salida tiene 
un cuadro.  

Para cambiar (es decir, conmutar) el estado de una entrada, haga clic con el botón izquierdo en el 
cuadro de la entrada deseada. 

Un cuadro azul indica estado TRUE (verdadero). 

Después de configurar (haciendo clic en ella) una entrada concreta, el estado de las salidas se 
ajusta siguiendo la lógica de la aplicación programada. En la vista en línea, los cuadros de las 
salidas indican el estado correspondiente. 

De esta forma puede verse el estado de las entradas y salidas simuladas en la configuración del 
PLC (además de en la vista de POU). 
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5. Para detener el modo de simulación, seleccione Online > Logout (en línea > cerrar sesión). 

 

Descarga del programa en el PLC 
Antes de descargar el programa en el PLC… 

 Es necesario compilar correctamente el proyecto. 

 Si no lo ha hecho ya, conecte el PLC (interfaz serie) al ordenador (puerto USB) utilizando el cable de 
programación TK503. 

 Encienda el PLC situando el interruptor RUN/STOP (marcha/paro) del PLC en la posición RUN. 

 Asegúrese de haber cerrado el modo de simulación. Para salir del modo de simulación, seleccione 
la opción de menú Online > Simulation Mode (en línea > modo de simulación). Después de 
deseleccionar esta opción, la marca de verificación    desaparece. 

Proceda de este modo: 

1. Seleccione Online > Login (en línea > iniciar sesión). 

 

Manual de primeros pasos      29 Kit de iniciación AC500-eCo     AC500/Publicado: 04.2010 



2. En el cuadro de diálogo que se abre, haga clic en Yes (sí) para confirmar y descargue el proyecto en 
el PLC. 

 

3. Cómo crear un proyecto de arranque: 

Cuando se selecciona el comando Online > Create boot project (en línea > crear proyecto de 
arranque), el PLC puede descargar y ejecutar automáticamente el proyecto de aplicación después 
de un reinicio. Esto se consigue guardando el programa descargado en una memoria no volátil 
(memoria Flash).  

En caso contrario, si no se utiliza este comando, es preciso volver a cargar (es decir, descargar) 
manualmente el programa cada vez que se enciende el PLC. 

 

4. Seleccione Online > Run (en línea > ejecutar) para comenzar a ejecutar el programa en el PLC. 
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Visualización del programa 
La visualización permite diseñar una representación gráfica de las variables del proyecto. En el modo en 
línea, estos elementos gráficos pueden cambiar, por ejemplo, de color, tamaño o posición en función del 
estado (valor) actual de la variable. Es posible, además, influir sobre los valores de las variables. 

 El PLC debe estar desconectado (es decir, ha de estarse fuera de línea) antes de modificar el 
programa. Para esto, seleccione la opción de menú Online > Logout (en línea > cerrar sesión). 

1. Haga clic en la pestaña Visualizations (visualizaciones, en la parte inferior de la ventana) 

 

2. Seleccione Project > Object > Add (proyecto > objeto > añadir) para introducir un nuevo objeto de 
visualización. 

 

3. Introduzca Visu_First_Program como nombre de la nueva visualización y confírmelo con OK. 

 

 Se ha introducido el nuevo objeto de visualización y puede comenzar el diseño. 
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En la barra de herramientas hay disponibles varios elementos gráficos para diseñar la visualización. 
Para seleccionar un elemento haga clic en el icono deseado.  

 

4. Introduzca un rectángulo para utilizarlo como elemento de entrada. 

 Haga clic en el icono del rectángulo. 

 Dibuje el rectángulo de este modo: 

En el cuadro de visualización, haga clic con el botón izquierdo en el punto de inicio del elemento que 
va a insertar. En nuestro ejemplo se trata de la esquina superior izquierda del rectángulo. Mantenga 
pulsado el botón del ratón y arrastre el ratón hasta el punto de destino deseado (esquina inferior 
derecha). Suelte el botón del ratón para insertar el objeto. 

 

5. Configure el nuevo elemento haciendo doble clic en él. En el cuadro de configuración que aparece, 
especifique las siguientes propiedades: 

 En el cuadro Category (categoría), seleccione Text (texto). 

 Introduzca digital input 04 en el campo Content (contenido). Este texto aparecerá en el elemento. 
También puede cambiar la fuente y posición del texto. 

 

 En el cuadro Category, haga clic con el botón izquierdo en Input (entrada) e introduzca .DI04 en 
el campo Toggle variable (variable de conmutación) para definir la relación entre el elemento y 
digital input 04.  
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CONSEJO 

Si se sitúa el cursor en un campo de entrada puede invocarse el Input Assistant 
(asistente de entrada) pulsando la tecla F2. En él pueden seleccionarse las variables 
anteriormente declaradas. 

  
 En el cuadro Category, haga clic con el botón izquierdo en Variables e introduzca .DI04 en el 

campo Change color (cambiar color). Con este ajuste el elemento cambiará de color durante la 
ejecución en función de su estado. 

 

 Defina un color para cada estado (TRUE y FALSE).  

Para hacerlo, haga clic en el botón Inside (interior) de ambos estados (es decir, en el área Color, 
así como en el área Alarm color [color de la alarma]).  

En la tabla de colores que aparece, seleccione un color y confírmelo con OK. 

Seleccione el color blanco para FALSE y el color naranja para TRUE. 
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 En el cuadro de diálogo de propiedades del elemento, haga clic en OK para confirmar la 
configuración del elemento definido. 

 

6. Repita los pasos 4 y 5 para crear y configurar un segundo botón de entrada denominado digital input 
05. 

7. Cree un elemento de salida. Esto se hace del mismo modo que para un elemento de entrada. Sin 
embargo, en el caso de una salida no es necesario especificar ninguna característica en la categoría 
Input (entrada). 

 Dibuje una elipse para utilizarla como elemento de salida. 

 

 En el cuadro Category, seleccione Text. 
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 Introduzca digital output 00 en el campo Content (contenido). Este texto aparecerá en el 
elemento. También puede cambiar la fuente y posición del texto. 

  

 En el cuadro Category, haga clic con el botón izquierdo en Variables e introduzca .DO00 en el 
campo Change color. Con este ajuste el elemento cambiará de color durante la ejecución en 
función de su estado. 

 

 Defina un color para cada estado (TRUE = activado y FALSE = desactivado).  

Para hacerlo, haga clic en el botón Inside de ambos estados (es decir, en el área Color, así 
como en el área Alarm color).  

En la tabla de colores que aparece, seleccione un color y confírmelo con OK. 
Seleccione verde para FALSE y rojo para TRUE. 

 En el cuadro de diálogo de propiedades del elemento, haga clic en OK para confirmar la 
configuración del elemento definido. 
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8. Repita el paso 7 para crear un segundo elemento de salida denominado digital output 01.  

 La visualización de ejemplo queda completada. 

 

9. Descargue el programa en el PLC y ejecute el programa en el modo de simulación: 

 Seleccione la opción de menú Online > Simulation Mode. 

 Seleccione Online > Login. 

 

 A continuación, seleccione Online > Run. 

 

Manual de primeros pasos      36 Kit de iniciación AC500-eCo     AC500/Publicado: 04.2010 



Cambio del estado de las entradas  
Después de aplicar las señales de entrada DI04 y DI05 haciendo clic con el botón izquierdo en el cuadro 
de la entrada deseada en PLC Configuration (configuración del PLC), la visualización muestra su 
estado y cambios de estado durante la ejecución.  

Dependiendo de los estados de entrada aplicados, las salidas actuarán y cambiarán de color en la 
ventana de visualización. 

La captura de pantalla se ha realizado con las siguientes condiciones: 

 Entrada digital 04 = TRUE y entrada digital 05 = FALSE; 

 Salida digital 00 = FALSE y salida digital 05 = TRUE  

 

Salir del software 
1. Para salir del software, seleccione en primer lugar la opción de menú Online > Logout. 

 

2. Una vez situado el software "fuera de línea", puede hacer clic en File > Exit (archivo > salir). 
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Ayuda 
Para obtener información más detallada, consulte el sistema de ayuda en línea integrado. 

Para abrir la ventana de ayuda en línea, pulse la tecla F1 en la ventana activa, en un cuadro de diálogo o 
cuando el puntero del ratón esté situado sobre una opción de menú. 

 

Cambio del idioma de la interfaz de usuario 
La interfaz de usuario puede visualizarse en varios idiomas. Puede cambiar el idioma utilizado en 
cualquier momento de este modo: 

1. Seleccione la opción de menú Project > Options (proyecto > opciones)  

2. En el cuadro Category (categoría), haga clic con el botón izquierdo en Desktop (escritorio) 

3. Seleccione la entrada deseada del cuadro combinado Language (idioma).  

4. Confirme el cuadro de diálogo Options (opciones) con OK. 
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¡Felicidades!  
Ahora ya sabe cómo programar el PLC AC500-eCo. En el apéndice encontrará más ejercicios. Si desea 
saber más sobre la programación puede continuar con los ejercicios del apéndice. 

El código fuente de todos los ejemplos de este manual puede encontrarse en “Source Files in Getting 
started Examples”, en el CD “Getting Started”.  

Encontrará más información técnica sobre el AC500-eCo en la ayuda en línea del software de 
programación PS501.  

Visite la página Web de ABB http://www.abb.com/PLC para obtener más información sobre los productos 
AC500 y sus servicios de asistencia.  
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Apéndice  
En este Apéndice encontrará más ejercicios de programación para el PLC AC500-eCo.   

2o ejemplo: Sistema de medición con diagrama de escalera 
Este ejemplo simula un sistema de medición. Los siguientes componentes (conmutadores) son 
relevantes: 

 SW1: conmutador 1, que abre la válvula. 

 SW3: conmutador 3, que simula el flujo de líquido; un pulso (generado activando [ON] y 
desactivando [OFF] SW3) representa el paso de 1 litro de líquido por la válvula. Una vez hayan 
pasado 10 litros por la válvula, esta se cerrará. 

 SW6: representa un interruptor de paro de emergencia que se utiliza para cerrar la válvula. 

El sistema de medición controla el flujo de líquido abriendo y cerrando la válvula. 

 El estado por defecto de la válvula es cerrado. 

 Si se activa SW1 durante al menos 2 segundos y se vuelve a desactivar, la válvula se abre. 

 SW3 se utiliza para simular el flujo (como ya se ha descrito en el 2.o punto de la lista anterior). 

 A continuación debe transcurrir un periodo de reposo de al menos 10 segundos hasta que la válvula 
pueda volver a abrirse con SW1. 

 Cuando se activa SW6 (paro de emergencia), la válvula se cierra inmediatamente y permanece 
cerrada hasta que se desactive SW6. 

La tabla siguiente muestra la configuración de las E/S integradas. 

Nombre del símbolo Comentario en la configuración del 
PLC 

Significado 

START Botón de inicio SW1, que se utiliza para abrir la válvula 

IMPULSE Unidad de control de flujo SW3, que se utiliza para simular el pulso 
de control de flujo 

EMERGENCY_STOP Paro de emergencia SW6 representa un botón de paro de 
emergencia conectado 

VALVE Válvula ABIERTA Válvula abierta. 
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SW1: Inicio  SW3: Control de flujo de salida SW6: Paro de emergencia 

Creación del proyecto de ejemplo 
1. Abra el software Control Builder del AC500. 

2. Cree un nuevo proyecto haciendo clic en el botón New (nuevo) o seleccionando la opción de menú 
File > New (archivo > nuevo). 

 

3. En la ventana Target settings (ajustes de objetivo) que se abre, seleccione la CPU AC500 PM554 
V1.3 en la lista desplegable Configuration (configuración). 

 

4. En este momento no es necesario realizar más ajustes de objetivo. Simplemente haga clic en OK 
para cerrar la ventana. 

5. En la ventana New POU (nueva POU) que se abre, especifique el tipo y lenguaje de la POU tal y 
como se muestra en la captura de pantalla. En este ejemplo utilizaremos el lenguaje de 
programación de diagrama de escalera (LD).  

A continuación, confírmela con OK. 

 

6. Haga clic en l botón Save (guardar) o seleccione la opción de menú File > Save (archivo > guardar). 
En el cuadro de diálogo Save As (guardar como…), introduzca Metering_System como nombre del 
proyecto y haga clic en el botón Save. 
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Configuración del PLC 
Una vez creado el nuevo proyecto, es necesario definir la configuración y nombres simbólicos de las E/S.  

1. Abra la pestaña Resources (recursos, en la parte inferior de la ventana) y haga doble clic en el 
icono PLC Configuration (configuración del PLC). 

2. En el árbol de la derecha, abra la carpeta AC500 y modifique los nombres de las E/S tal y como se 
muestra a continuación. 

 
CONSEJO 

Consulte el apartado "Especificación de la configuración de hardware", en la página 15, 
para más información sobre la modificación de los nombres simbólicos. 
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Edición de código en diagrama de escalera (LD) 
El sistema de programación dispone de una barra de herramientas para insertar objetos LD. Cuando 
sitúe el puntero del ratón sobre uno de los iconos de esta barra, un cuadro de ayuda muestra una breve 
descripción del funcionamiento del icono. 

 

1. Para poder editar el código del programa, abra la pestaña POUs y haga doble clic en el icono 
PLC_PRG (PRG). 

2. Añada un contacto haciendo clic en el icono correspondiente de la barra de herramientas o 
seleccionando la opción en el menú contextual. 

 

3. Cambie el nombre del contacto seleccionando el marcador de posición ??? e introduciendo el 
nombre de variable START. 

 

Haga clic con el botón izquierdo en cualquier lugar de la red para aplicar el cambio del nombre de 
variable. 

 

4. Añada un bloque Timer (TON) utilizando alguno de los métodos anteriormente descritos (véase el 
paso 2 en la página 18). 

 

5. Cambie el nombre del bloque a TIMER_1 y pulse Intro para aplicar la entrada. 

 

 Se abre el cuadro de diálogo Declare Variable (declarar variable). 
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6. En el cuadro de diálogo Declare Variable están disponibles las siguientes propiedades de declaración. 

 

 La propiedad Class (clase) de la variable puede definirse como VAR, en el caso de las variables 
locales, y VAR_GLOBAL para las variables globales. Las palabras clave VAR_OUTPUT y 
VAR_INPUT se utilizan para declarar las variables de entrada y salida cuando se desarrollan bloques 
de funciones. 

 En el campo Name (nombre) debe especificarse el nombre de etiqueta. 

 Defina el campo Type (tipo) seleccionando una entrada en el cuadro combinado. 

 Puede definir un Initial Value (valor inicial) para las variables o valores de conjunto. Esto se hace 
abriendo el cuadro de diálogo. 

 Mediante el campo Address (dirección) puede asignar nombres de etiqueta con direcciones físicas 
reales. 

 El campo Comment (comentario) puede utilizarse para fines de documentación. 

 CONSTANT (casilla de verificación opcional) puede declararse local o globalmente.  

 Las variables declaradas con el indicador RETAIN (permanentes) conservan sus valores (es decir, no 
cambian), incluso después de un apagado incontrolado del sistema de ejecución (apagado/encendido) 
o una operación “Online Reset” (restauración en línea) en CoDeSys. 
Esta casilla de verificación opcional solamente está disponible para las variables globales. 

 Las variables PERSISTENT solamente conservan sus valores (es decir, no cambian) después de 
descargar el programa. Esta casilla de verificación opcional solamente está disponible para las 
variables globales. 

Después de completar el cuadro de diálogo, haga clic en OK para aplicar los ajustes introducidos y, a 
continuación, haga clic en cualquier lugar de la red. 

 
CONSEJO 

Cuando el cursor esté dentro de un campo de texto: 
- Mayúsculas + F2 vuelve a abrir el cuadro Auto Declaration (declaración automática). 
- F2 abre el Input Assistant (asistente de entrada) para seleccionar una variable ya declarada. 

  
7. Ajuste el temporizador a 2 segundos: 

 Haga clic en el marcador de posición ??? de la entrada PT. 

 

 Introduzca t#2s 

Haga clic con el botón izquierdo en cualquier lugar de la red para confirmar el ajuste. 
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8. Añada una bobina haciendo clic en el icono correspondiente de la barra de herramientas. 

 

9. Introduzca M1 como nombre de la bobina y pulse Intro para aplicar el ajuste. 

10. Complete el cuadro de diálogo Declare Variable del modo mostrado y confírmelo con OK.  
A continuación, haga clic con el botón izquierdo en cualquier lugar de la red para finalizar la 
operación de edición. 

 

 La red 0001 ha quedado completada y debe tener este aspecto: 

 

11. Inserte una segunda red debajo de la red 0001 haciendo clic en el icono correspondiente de la barra 
de herramientas. 
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12. Complete el código LD gráfico tal y como se muestra en la figura siguiente. 

 

Compilación del proyecto de ejemplo 
Compile el proyecto seleccionando la opción de menú Project > Build (proyecto > compilar). 
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Descarga del proyecto de ejemplo en el PLC 
Después de compilar correctamente el proyecto, puede descargarlo en el PLC.  

 Antes de la descarga: asegúrese de que el interruptor RUN/STOP del PLC está en la posición RUN. 

1. Seleccione Online > Login (en línea > iniciar sesión) 

 

2. Seleccione Online > Run (en línea > ejecutar) 

 

Códigos de error 
Cuando se establece una conexión entre el PLC y el ordenador pueden producirse diversos errores. 
Estos errores se clasifican en categorías específicas. 

 Con el comando diagshow all (ver todos los diagnósticos) puede ver todos los errores del PLC, 
divididos en las categorías de error E1 a E4.  

 Para restaurar todos los errores, introduzca el comando diagreset (restaurar diagnósticos). 

 Al introducir el comando ?, el explorador del PLC (PLC Browser) muestra una lista de todos los 
comandos disponibles junto con una breve descripción. 
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Consulte la ayuda en línea de CoDeSys para obtener información más detallada. 

Prueba del programa  

El programa puede probarse en el modo de simulación. El estado de los conmutadores puede simularse 
en PLC Configuration. Aquí, cada entrada y salida dispone de un cuadro. El estado de una entrada 
puede cambiarse (es decir, conmutarse) haciendo clic con el botón izquierdo en el cuadro de la entrada 
deseada.  
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3er ejemplo: Depósito de agua caliente con texto estructurado (ST) 
Este ejemplo muestra una aplicación compleja con módulos de CPU AC500-eCo y módulos de E/S 
S500-eCo. Se compone de tres partes, cada una de las cuales se crea en una POU aparte. Además de 
este Kit de iniciación, deberá adquirir otros módulos de E/S S500-eCo para poner en práctica la 
aplicación de hardware. 

1º parte: Control de nivel 

Se conecta una bomba al depósito mediante una válvula. Un sensor mide el nivel de líquido en el interior 
del depósito. Si el nivel es menor de 4 m, la válvula de la bomba se abre y, si el nivel de líquido supera 
los 9 m, la válvula se cierra. 

2ª parte: Control de temperatura 

Un sensor RTD (Ni1000) mide la temperatura del líquido. Si la temperatura es inferior a 60 °C, el 
calentador instalado en el depósito se activa para calentar el líquido. Si la temperatura es superior a 
120 °C, el calentador se desactiva.  

3ª parte: Vertido de agua caliente por el usuario 

Si el nivel de líquido está entre 4 y 9 m y la temperatura entre 60 y 120 ° C, el usuario puede verter agua 
caliente. 

Componentes necesarios: 

 1 CPU del tipo PM554 

 1 fuente de alimentación de 24 V CC 

 1 módulo de E/S digitales S500 DX561 

 1 módulo de entrada analógica S500 AI561 

 1 módulo de entrada analógica RTD S500 AI562 con Ni1000, -50 °C…+150 °C (dos hilos) 

 1 ordenador con el software de programación PS501 instalado 

 1 cable (TK503) para conectar la CPU al ordenador. 

Dirección Significado Dispositivo 

%QX4000.0 Alarma: nivel bajo o excesivo (waterLevel) PM554_DO 

%QX4000.1 Alarma: la temperatura supera el valor máximo o mínimo permitido 
(waterTemp) 

PM554_DO 

%QX4000.2 Alarma para el usuario: no es posible verter agua caliente PM554_DO 

%IX0.0 Conmutador accionado por el usuario para verter agua caliente DX561_DI 

%QX0.0 Señal de control de válvula (abrir/cerrar) DX561_DO 

%QX0.1 Señal de control del calentador (calentador activado/desactivado) DX561_DO 

%QX0.2 Indicador: el usuario puede verter agua caliente DX561_DO 

%IW1 Valor medido: nivel de líquido  AI561_AI 

%IW5 Valor medido: temperatura AI562_AI_RTD
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Creación del proyecto de ejemplo 
1. Abra el software Control Builder del AC500. 

2. Cree un nuevo proyecto haciendo clic en el botón New (nuevo) o seleccionando la opción de menú 
File > New (archivo > nuevo). 

 

3. En el cuadro de diálogo Target Settings (ajustes de objetivo) que se abre, seleccione la CPU AC500 
PM554 V1.3 en la lista desplegable Configuration (configuración). 

 

4. En este momento no es necesario realizar más ajustes de objetivo. Simplemente haga clic en OK 
para cerrar la ventana. 
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5. En el cuadro de diálogo New POU (nueva POU) que se abre, especifique el tipo y lenguaje de la 
POU tal y como se muestra en la captura de pantalla. En este ejemplo utilizaremos el lenguaje de 
programación de texto estructurado (Structured Text, ST). 
A continuación confírmela con OK. 

 

 Se abre el ST Editor (editor de ST): 

 

6. Haga clic en el botón Save (guardar) o seleccione la opción de menú File > Save (archivo > 
guardar). 
Introduzca Tank como nombre del proyecto y haga clic en el botón Save. 
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Especificación de la configuración de hardware 
Una vez creado el nuevo proyecto, es necesario especificar la configuración de hardware. 

1. Abra la pestaña Resources (recursos, en la parte inferior de la ventana) y haga doble clic en el 
icono PLC Configuration (configuración del PLC).  

 

2. En el árbol de la derecha, abra la carpeta AC500 tal y como se muestra a continuación. 
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3. En este árbol debemos insertar los tres módulos de E/S utilizados (DX561, AI561 y AI562). Estos 
módulos se conectan directamente al bus de E/S de la CPU.  

Para hacerlo, haga clic con el botón derecho en el icono I/O-Bus. Se abre el menú contextual. Abra 
el submenú Append Subelement (añadir subelemento) y seleccione el módulo de E/S DX561 como 
se muestra a continuación.  

 

Repita este paso para el resto de módulos de E/S (AI561 y AI562). 

El nodo I/O-Bus del árbol de hardware está ocupado por los módulos utilizados: 

 

Manual de primeros pasos      53 Kit de iniciación AC500-eCo     AC500/Publicado: 04.2010 



Introducción de comentarios simbólicos para las E/S 
1. En el nodo OnBoardIO del árbol:  

 abra el nodo Digital Outputs 0-5  

 haga clic dos veces en la entrada asociada a la salida digital 0 (%QX4000.0)  

 escriba Level_Alarm como nombre simbólico.  

 en el campo Comment (comentario) de la derecha (en el área Base parameters [parámetros 
base]), introduzca waterLevel, ALARM.  

 

Complete la entrada haciendo clic en cualquier otro canal. 

 

2. Repita el paso 1 para las demás salidas integradas utilizando los siguientes nombres/comentarios 
simbólicos: 

 Salida 1 (%QX4000.1): nombre simbólico Temp_Alarm y comentario waterTemp, ALARM 

 Salida 2 (%QX4000.2): nombre simbólico Alarm y comentario cannot dump hot water, ALARM 

 Cuando haya terminado, la configuración de las salidas integradas debe tener este aspecto: 
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3. Ahora debe especificar las entradas del mismo modo:  

En el nodo I/O-Bus del árbol:  

 abra la rama DX561 y, en ella, el nodo Digital Inputs 0-7  

 haga clic en la entrada asociada a la entrada digital 0 (%IX0.0)  

 introduzca Start como nombre simbólico  

 en el campo Comment de la derecha (área Base parameters), introduzca “Switch for user” 
(conmutador del usuario).  

Complete la entrada haciendo clic en cualquier otro canal. 
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4. Repita el paso 3 para las salidas digitales del módulo DX561.  

 El árbol debe tener este aspecto: 

 

5. Ahora vaya a la rama AI561 y abra el nodo Analog Input 0-3. 

 haga clic en la entrada asociada a la entrada analógica 0 (%IW1)  

 e introduzca Fluid como nombre simbólico  

 en el campo Comment de la derecha (área Base parameters), introduzca “Fluid position 
gathering” (obtención de la posición del fluido).  

 

6. Para especificar esta entrada analógica, abra la pestaña Channel parameters (parámetros de 
canal, a la derecha).  

Seleccione 0..10 V en la lista desplegable Value (valor). 

Complete la entrada haciendo clic en cualquier otro canal. 
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7. Vaya a la rama AI562 y abra el nodo Analog Input 0-1. 

Haga clic en la entrada asociada a la entrada analógica 0 (%IW5) e introduzca Temp como nombre 
simbólico.  

En el campo Comment de la derecha (área Base parameters), introduzca “Temperature gathering” 
(obtención de temperatura).  

 

8. Para especificar esta entrada analógica, abra la pestaña Channel parameters (parámetros del 
canal, a la derecha).  

Seleccione 2 wire NI1000 -50..+150deg en la lista desplegable Value (valor). 

Complete la entrada haciendo clic en cualquier otro canal. 
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Apertura del editor de ST 
Para organizar y editar el proyecto debe abrir la pestaña POUs (en la parte inferior de la ventana) y 
hacer doble clic en el icono PLC_PRG (PRG). El editor de ST se abre a la derecha. 

 

Organización del programa 
Vamos a dividir el programa en las tres partes siguientes: 

 Parte 1: Fluid_Position_Control 

 Parte 2: Temp_Control 

 Parte 3: Output_Control 

Se va a crear una POU (Program Organization Unit o unidad de organización de programas) distinta para 
cada parte del código. 

1. Haga clic con el botón derecho en el icono de la carpeta POUs y seleccione Add Object (añadir 
objeto) en el menú contextual. 

 
2. En el cuadro de diálogo New POU (nueva POU) que se abre, introduzca el nombre 

Fluid_Position_Control. Esta POU será la parte 1 del proyecto. Haga clic en Program (programa) 
como tipo de POU y seleccione el lenguaje ST. 

3. Repita los pasos 1 y 2 para las otras dos partes (POU). Cree ambas como POU ST del tipo 
programa. Introduzca un nombre para cada POU tal y como se muestra a continuación: 
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Desarrollo del código ST 
1. En la lista de POU, haga doble clic en Fluid_Position_Control. Edite el código en la ventana del 

editor de ST de la derecha, tal y como se muestra en la figura siguiente. 

Observe los comentarios introducidos después de algunas declaraciones en ST. Todos los 
comentarios comienzan por (* y acaban en *). Los comentarios aparecen por defecto en color verde. 

 

2. En la lista de POU, haga doble clic en Temp_Control. Edite el código en la ventana del editor de ST 
de la derecha como se muestra en la figura siguiente. 
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3. Haga doble clic en el icono Output_Control y edite el código como se muestra en la figura siguiente. 

La ventana situada sobre el editor muestra las declaraciones de variables para la POU que se está 
editando actualmente. En nuestro ejemplo pueden verse las declaraciones de dos variables 
booleanas: waterLevel y waterTemp. 

 

 El proyecto ahora contiene cuatro POU del tipo programa. Sin embargo, el programa 
PLC_PRG (PRG) está destinado a ser el programa principal que debe invocar a los tres 
programas definidos por el usuario que acaba de insertar. 

4. Cree una carpeta a la cual pueda trasladar los programas definidos por el usuario. Esta carpeta no 
afecta a la lógica programada, pero mejora la organización del proyecto.  

Para hacerlo, haga clic con el botón derecho en el icono de la carpeta POUs y seleccione New 
Folder (nueva carpeta) en el menú contextual. 
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5. Cambie el nombre de la nueva carpeta haciendo clic con el botón derecho en su icono y 
seleccionando Rename Object… (cambiar nombre de objeto) en el menú contextual. 

 

En la ventana Rename Object que se abre introduzca el nombre Real_Control y confirme con OK. 

 

6. Traslade los iconos de las POU del usuario a la carpeta Real_Control:  

 haga clic con el botón izquierdo en cada uno de los iconos de las POU  

 mantenga pulsado el botón del ratón mientras arrastra el ratón hasta el icono de la carpeta 
Real_Control  

 suelte el botón del ratón sobre la carpeta para soltar dentro de ella la POU. 

Una vez hecho esto con todas las POU definidas por el usuario, el árbol de POU debe tener este 
aspecto: 
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Por último, debe modificar las llamadas a programa de la POU principal. 

7. En la lista de POU, haga doble clic en PLC_PRG. 

8. En la ventana de programación de la derecha, haga clic con el botón derecho en la primera línea de 
código y seleccione Input Assistant… (asistente de entrada) en el menú contextual. 

 

9. En la ventana Input Assistant que se abre, seleccione User defined Programs (programas 
definidos por el usuario) y, en la lista de programas de la derecha, Fluid_Position_Control. 
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10. La llamada de programa para esta POU definida por el usuario puede verse ahora en el código ST 
del programa principal.  

Pulse Intro. 

 

11. Repita los pasos 8 y 9 para los programas definidos por el usuario Temp_Control y Output_Control. 

 
CONSEJO 

En ST, todas las llamadas de programa deben comenzar en una nueva línea. Por esta 
razón debe invocarse el Input Assistant haciendo clic con el botón derecho en una línea 
vacía. 

  
 En la siguiente captura de pantalla se muestra el resultado. El programa principal PLC_PRG 

contiene una llamada para cada POU del programa definida por el usuario. 

 

Ha completado el proyecto y ahora puede comenzar a compilarlo. 

Compilación del proyecto 
Compile el proyecto seleccionando la opción de menú Project > Build (proyecto > compilar). 

 

Si no se detecta ningún error durante la compilación, el mensaje 0 errors, 0 warnings  (0 errores, 0 
advertencias) aparece en el cuadro de mensajes de la esquina inferior derecha. 

Manual de primeros pasos      63 Kit de iniciación AC500-eCo     AC500/Publicado: 04.2010 



Conexión de la CPU y los módulos S500 
Es posible conectar un máximo de 7 módulos de E/S S500 al PLC. La conexión eléctrica del bus de E/S 
se realiza automáticamente al conectar los módulos uno al lado del otro sobre la guía DIN. 

 
ATENCIÓN 

Antes de montar y conectar los componentes entre sí, asegúrese de que todas las 
fuentes de tensión (alimentación, tensión de proceso) están desconectadas. 

  
Proceda del modo siguiente: 

1. Monte un PLC PM554 en la guía DIN. 

2. Inserte un módulo DX561 en la guía DIN y desplácelo lateralmente hasta el lado derecho del 
PM554. 

3. Inserte un módulo AI561 en la guía DIN y desplácelo lateralmente hasta el lado derecho del DX561. 

4. Inserte un módulo AI562 en la guía DIN y desplácelo lateralmente hasta el lado derecho del AI561. 

5. Conecte el PLC (en COM1) a la interfaz USB del ordenador con el cable de programación TK503. 

6. Conecte el PM554 a la fuente de alimentación de 24 V. 

7. Conecte las entradas y salidas integradas del PM554 a la tensión de proceso. 

8. Conecte los módulos DX561, AI561 y AI562 a la tensión de proceso. 

 
CONSEJO 

Para obtener más información sobre la CPU y los módulos de E/S, consulte los datos 
técnicos del PLC AC500. 

 
ATENCIÓN 

Respete siempre las regulaciones vigentes sobre seguridad al instalar, manipular y 
poner en funcionamiento equipos eléctricos. No seguir estas instrucciones y normas 
puede ocasionar daños al equipo, lesiones personales o incluso la muerte. 
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Descarga del proyecto 

 
NOTA 

Los módulos de E/S DI561, AI561 y AI562 no forman parte del Kit de iniciación. Para 
ejecutar este ejemplo utilizando el hardware debe adquirir estos módulos de E/S. Sin 
embargo, puede utilizar el modo de simulación para ejecutar y probar el proyecto de 
ejemplo sin necesidad de conectar el hardware. 

  
Una vez conectado el hardware es posible descargar el programa en el PLC.  

 Antes de la descarga: asegúrese de que el interruptor RUN/STOP del PLC está en la posición RUN. 

1. Seleccione Online > Login (en línea > iniciar sesión). 

 

2. Seleccione Online > Run (en línea > ejecutar) 

 

Ahora puede comprobar si el PLC ejecuta correctamente el programa. 
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Contacte con nosotros 
 
 
 
 
 
 
ABB 
Discrete Automation and Motion 
Drives y PLC's 
Polígono industrial S.O. 
C/ Illa de buda, 55 
08192 San Quirze del Vallès 
Barcelona 
Tel. : +34 93 728 85 00 
Fax : +34 93 728 76 59 

Como parte de la mejora constante de sus productos, 
ABB se reserva el derecho a modificar las 
características o los productos descritos en este 
documento. La información proporcionada no tiene 
carácter contractual. Para más información, póngase 
en contacto con la compañía ABB que comercialice 
estos productos en su país. 
 
ABB Global Contact Directory 
El ABB Contact Directory (http://www.abb.com/
contacts/) le ayuda a encontrar a los contactos locales 
para los productos de ABB en su país. 
Seleccione el grupo de productos correspondiente en el 
menú desplegable de la derecha o en la página. 
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